Scan by Zman™.

Starter Hacks

g .

ATV, W 2 T e



Unleash
Your Mac’s
Hidden /5=
Powers &:=i»p

ea the word hacker and you probably think of some unshaven dude in
a dimly lit room doing something horribly illegal. Right? While that may an S O J p
be one definition of hacker, another definition of the word describes

you—the Mac addict who is willing to tweak your Mac in slightly unorthodox

ways to unleash power, speed, and customization options you normally U O U 2
couldn't even touch.

The last time we ran an article about hacking was April 2000 (you'll find it
on the Disc), but a lot has changed since then—namely, the release of Mac M
0S5 X and its wonderful Unix-based (aka hacker-friendly) underpinnings. Mac aC SH
0S 9 offered much in the way of small customization tweaks, but little in the
way of true power hacks. Mac OS X changes everything. From giving your /
Mac a performance boost to changing your Trash icon to adding convenient an ey re
ease-of-use options, hacking can now be much more than a geeky pastime—
it can be useful, too. And for those of you who have never hacked your OS, :
or are intimidated by the concept of digging around in places Apple doesn't eas | e r th an
want you to go, don't worry. Hacking doesn't have to be difficult or even
dangerous. In fact, we've included a number of beginner- and intermediate- '
level hacks for both Mac OS 9 and Mac OS X that any semiproficient Mac O U ']:h | n k l
user should be able to perform (contrary to belief, hacking is not brain y '
surgery). And we haven't forgotten you hard-core hackers, either—check out
the "Advanced Hacks" section.
One final, comforting note: We left each of these hacks on our test
machines, and they're running beautifully. Surprised? You shouldn't be. You

didn't really think we'd show you how to do something we weren't wilingto by Dave Hamilton
perform on our own precious Macs, did you? photograph by Mark Madeo

(X Denotes a Mac 05 X hack

. Denoles a Mac D5 9 hack



Starter Hacks

Think hacking

is just for the pros? Think again.

These hacks are hard to screw up.

GEEK SPEAK: Run the Finder as root

ENGLISH: Gain Easy Access to Finder Files

Have a file or document that refuses to let you delete or move it? More
than likely, the reason is that the process requires authentication, yet
Mac 05 X doesn’t give you the ability to authenticate yourself in the
Finder. The fix? Run the Finder in root mode.

Say what? In Mac 05 X (as in all Unix-based operating systems),
one superuser is always more powerful than the rest. This useris
named roof and is often the sole owner of many system-level files that
determine key seltings for the entire computer (for example, root owns
the files that tell your Mac how to start up, and what services to enable
each time it does). The ability to run your Finder as root allows you to
copy, move, and delete root-owned files, like those that control your
system icons or contain your window settings. Now you could take a
trip to the Terminal’s command line to log in as root (see “Terminal
Trouble,” p26). but then you lose the benefit of operating within a GUI.
By running your Finder as root, you can move all those previously
untouchable files from the comfort of the familiar Mac 05 interface.

How to Do It

STEP 1: Grab a copy of the shareware
Pseudo (515, http://personalpages.tds.net
[=brian_hill/pseudo.html) and launch it.
Pseudo, like its command-line counterpart
sudo (get it?), allows you to run just about
any program as root—a very handy utility,
as you'll soon see. Open up a Finder
window. From your hard drive, navigate
through the following folders: System »
Library » Core Services. In the Core Services

Make sure you choose the
Finder of the kind
Application, not Classic
Application—alherwise this
hack won't work.

folder you will find two copies of the Finder. Locate the one that is of
type Application (not type Classic Application). You can find this
information by highlighting the file and choosing Show Info from the
File menu.

STEP 2: Drag that copy of the Finder onto
the Pseudo window. Pseudo will likely ask
you to enter your password. This is so the
systern knows it's kosher to run your program
as root. Note: You need Administrator access
to use Pseudo.

W Gpen It o Bt

Iritem Admn ki er

Pseudo allows you o run
programs as rool right

STEP 3: Once you've authenticated from the GUI in Mac DS X.

yourself, the Finder icon will bounce in the

Dock, the desktop will change to the default background, and a new
window will open after the Finder has relaunched. That new window
(and any windows you open subsequently) will have full root privileges
associated with them. This is very handy when you get one of those
mysterious files in Mac 05 X that refuses to let you delete it (strangely
enough, we've seen this happen with Microsoft Word documents
even). By acting as the root user, you can go in and delete these pesky
files. Just make sure you delete items you know are safe to delete and
to empty the Trash before quitting the root-enabled Finder, or else
you'll be stuck with a file permanently in the root Trash.

When you're finished with root, hold down Command-Option-
Escape and then choose to force-quit the Finder. This will quit the root-
enabled Finder, close all associated windows, and restore your
desktop to its normal background.

GEEK SPEAK: Enable Window Buffer Compression
ENGLISH: Give Mac OS X a Speed Boost

Mac 05 X saves the contents of each window in a portion of memory
called a window buffer. The 05 uses this buffer when it needs to
update windows or perform cool Aqua transparency effects. However,
saving the entire contents of each window in RAM takes up gobs and
gobs of memory. Depending on how many windows you have open
and how much RAM your system has, this process can slow you down.
Thank goodness Apple included a way of compressing the data in

this buffer, which can help speed up your Mac by freeing up RAM.
Inexplicably, Apple chose not to enable this feature. But that's OK—
you can hack your Mac to do it!

How to Do It

STEP 1: First you must make changes to a Mac 0S X preference file
called com.apple.windowserver, plist, which only root users can edit.
This file is in the Preferences folder within the Library folder at the root
level of your hard drive (not the Library folder in your home directory).
Before you do anything, duplicate this file (so you have a backup) by

holding down Option and dragging it to the desktop. Then, using your
new friend Pseudo (see “Gain Easy Access to Finder Files,™ above),
launch a copy of TextEdit as root to edit this file. To do so, go to your
Applications folder, and drag TextEdit on top of your Pseudo icon.

STEP 2: Once TextEdit opens, choose Open from the File menu, and
navigate to the original com.apple.windowserver.plist file.

LA PreferencePusa
LJ Prefeences

Navigate 1o the systemwide Preferences folder to find the right file.



GEEK SPEAK: Use ResEdit to Hack IE's PICT Resources
ENGLISH: Customize Internet Explorer’s Startup

Sure, you can change your Mac's startup screen, but it"s even cooler to change Intemet Explorer’s
startup logo and replace it with something a little more eye pleasing.

How to Do It

STEP 1: Make a copy of your Internet Explorer application. Just in case you mess up, you can go
back to the unmodified copy of your app. Find the picture you want to use in the startup scréen.
Using a graphics app like Photoshop or GraphicConverter, size the picture to be 504 pixels wide by
245 pixels high, and copy it to the system’s Clipboard.,

STEP 2: Open up a copy of
ResEdit (free, hitp:/ /download
.info.apple.com/Apple_Support
Area/Apple_Software_Updates
JEnglish-North_American
/Macintosh/Utilities). From
there, open up your original
Internet Explorer app. Double-
click the PICT resource, and
you'll see two copies of your
Explorer startup screen in
there, with IDs 401 and 402,

Opening up Internet Explorer
in ResEdil results in a
window containing all of
Explorer’s resources

You want the PICT resource.

|

Double-clicking the PICT resource
reveals all the pictures stored
within Explorer. Just replace 401
and 402 with your own image.

STEP 3: Open up ID 401 by double-
clicking its icon, and then choose Paste
from the Edit menu. Close that window
and repeat for 1D 4o02. If you experience
problems pasting in a picture, try
increasing ResEdit's memaory

Make Internet
Explorer more
personal by

allocation. Quit ResEdit, allowing it to pasting in
save the file. You're done! Now Internet your own
Explorer will have a personal touch precious
every time you start it up. pictures.

STEP 3: You see a file that looks like gibberish (it’s just XML, but unless you know how to read that,
it might as well be Swahili). Find the first <dict» tag, put the cursor undemeath, press Retum and type:

<key>BackingCompression</key>

<dict>
<key>compressionScanTime</key>
<real>=5.000000000000000e+00</real>
<key>*minCompressableSize</key>
<integer>8133i</integer>
<key>minCompressionRatio</key>
<real>1.100000023841858e+00</real>

</dict>

Insert this text into your com.apple
Mwindowserver.plist file to enable Window
Bulfer Compression.

STEP 4: Save this file. Go to the Apple menu, choose Log Out, log back in again, and you'll be
running with Window Buffer Compression enabled! If you're lucky, your system will feel snappier
(it even sped up our G2 system). This hack should make a difference to those of you who litter your
desktops with open windows (you know who you are),

Understanding
the OS

To truly appreciate the art of hacking, you
should first understand how the operating
systermn works.,

Mac OS5 9 splits most files, including
documents and applications, into two
distinct parts—the data fork, which
houses raw data (like word procassing
tenct or the bits necessary to reconstruct a
JPEG image), and the resource fork, the
portion of the file that stores the info
needed to make an app work property.
Resources typically hold icons, menus,
emor messages, and the like. In 05 9,
you typically hack the resource fork of
individual files using programs like
ResEdit, which allows you to modify the
individual resources to your liking.

With Mac OS X, things are a bit different.
Unix is at the core of everything, and it
stores all settings in text files. But that's of
no concem to most users, thanks to
Apple's use of wizards—menus,
checkboxes, and other graphical interface
elemeants that allow you to easily edit the
settings in these text files. Many more
options are available than you'll find in
Apple's graphical wizards—ior instance,
window minimizing effects beyond Scale
and Genie. But there's a way around that,
natch. The Terminal application provides
you access to raw Unix code and
settings, allowing you to make tweaks
you otherwise couldn't.

Achtung
Hackers!

While most of the hacks here are fairy
safe and harmiess, you should only make
modifications to your system if you're OK
with the worst-case scenario: losing all
the data on your machine, Of coursa,

that happens rarely; you're more likely to
screw up the file or app you're hacking.
Hera are some precautions and words

of waming:

1. Back up before you try anything.

2.Keep a bootable CD by your side in
case somathing should go wrong.

3.Whenever you can, make a copy of a
file you are going to hack. This way
you'll have a duplicate for restoring
your system.

4, Remember that each system is
different. What works on our Macs
may not work on yours.

5. Follow our instructions! Don't stray or
you could end up in a bind.
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GEEK SPEAK: Use the Terminal to Tweak Your Mouse Scaling Defaults

ENGLISH: Speed Up Your Mouse

Many Mac users like their mice so twitchy that a small gust from the
heater kicking on sends their cursor to the other side of the screen.
Some third-party mice come with software that allows you to adjust
this setting beyond the norm, but if you're stuck with either an Apple-
branded mouse or a third-party mouse that doesn’t yet have Mac 05 X
drivers available (cough, Microsoft!), you're out of luck if you want to
increase your mouse-tracking speed beyond what the System
Preferences allow. Or are you?

How to Do [t

STEP 1: Open the Terminal program (inside the Utilities Folder).
You will see a window with a flashing cursor at a command prompt.
This window is a shell for Mac 05 X's underlying Unix environment
(for more info on the Terminal, see “Terminal Trouble,” p26). At this
prompt, type the following and press Retumn:

defaults write --globalDomain
com.apple.mouse.scaling -float 3.0

STEP 2: Now close that Terminal window by typing logout and
pressing Return, or if you really want to be Mr. or Ms. Joe Cool Unix
Hacker, you can simply press Control-D to accomplish the same task.
That's it! You're done.,

Too fast for you? Change mouse tracking back to the default setting
by issuing the command below in the Terminal (or try different float
values between 1.7 and 3.0 for various options).

defaults write --globalDomain
com.apple.mouse.scaling -fleoat 1.7

_fusribinflogin OE/EL)

By typing the right command into the Terminal window, you can speed up your
mouse instantly!

GEEK SPEAK: Hit the Command Line to Unlock Hidden Scroll Options
ENGLISH: Customize Your Scroll Bars

Mac 05 10.1 gives you two choices when it comes to window scrolling.
You can either have single scroll arrows at either end of the scroll bar
(one at the top and one at the bottom), or both ammows at the bottom of
the scroll bar (access these options in the General System Preferences
pane). There is one more option, though—having both arrows at both
ends of the scroll bar. Apple didn’t openly give users the ability to
enable this feature, but why should that stop you?

How to Do |t

STEP 1: Open up the friendly Terminal application. At the
prompt, type:

defaults write "Apple Global Domain”
AppleScrollBarVariant DoubleBoth

Jusrfbinflogin (typll

Don't worry if the command doesn’t fit on one line. Just keep typing—the
system won'l process what you've typed until you press Return.

STEP 2: Now you must either log out completely and log back in, or
quit and relaunch all your applications (including the Finder) to make
the change take effect systemwide.

STEP 3: To setyour scroll bars back to normal (with the up armow at
the top of the scroll bar and the down arrow at the bottom), type:

defaults write
AppleScrollBarVariant Single

"Apple Global Domain®

And to set your scroll bars so that both ammows are at the
boltom, type:
defaults write “"Apple Global Domain®
AppleScrollBarVariant DoubleMax

Ifyou don't like - s p—
living on the Unix 2 e Bl
edge, just go to the
General System
Preferences and
change your scroll
options. But you're a
hacker now—why do
things the easy way?

g abwary
I Detamens
A Foras slias
il Cames

1 Late Breaking News

|l Library

.ﬂ‘ Machddect Edin alias
' Mise

B Mapster Ingtaller Log
4 ralm

il Paim apes

See what a little Unix
can do? Now we have a
complete set of scraoll
arrows—lop, bottom,
right, and left.

J system
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GEEK SPEAK: Modify Your TCP/IP RWINS and Others to Maximize Network Performance
ENGLISH: Make Your Broadband Soar

Despite Apple’s contention that Mac 05 X will automatically tweak itself
for optimal performance, this isn't entirely true. By making a few surgical
strikes to the system's network-configuration settings, you may be able
to speed up your broadband connection (which typically has some extra
bandwidth available that it could use more efficiently). Those of you
who have direct DSL or cable connections (and are not going through a
router) will most likely have the most luck with this hack.

How to Do |t

STEP 1: Open the Terminal. Type sudo ==, press Retumn, and enter
your password when prompted. This command will put you in root
mode 50 you won't have to type sudo in front of every command.

800

Welcoms to Darwinl
[bwgdz~] jozzboX sudo -z

fusr {bin/iogin OVBR) -

¥e trust you hove received the usual lecture from the
Administrator. It usually bolls down to thasa two thin

1Y) Respect the privocy of others.
) Think before you type.

Password:
[owgiz~] roots ]

The sudo command lets Admin-specified users become the rool user, or
system administrator, without logging out.

STEP 2: Type the three commands below, following each with a Retum:
sysctl -w net.inet.tcp.recvspace=65536

This line increases the receive buffer, which allows the computer to
receive larger packets of data before stopping the flow and responding
to the appropriate host. Ideally, the fewer times your Mac has to
acknowledge the receipt of a package, the faster the overall transfer
(since the sending computer doesn't have to wait for a response as
many times before sending more information). The default recvspace
value is 32768—here you're changing this value to its maximum.

sysctl -w net.inet.tcp.sendspace=65536

This is the send buffer, which functions in the same way as the
receive buffer except that it affects uploads, whereas the receive buffer
affects downloads. For most folks, this setting won't matter as much,
but if you tend to send large email attachments or upload pictures to
your Web site, you may notice a difference if you play with this selting.

fusr/binflegin (ttypl)

: syseill - nel. inet.Lep. recvapace=65534
ral. Inet.lop.recyspace: J2TEE =» AS53E
[devephi™] ro net. Inet.top. sendspace=E5536
met. It tep. w: J2THA -» 5526

[dar 17] root® sysctl =e net. inet.tcp. deloysd_ock=g
net.icp.deloyed_ock: 1 =» @

] rooi® sxit

] dave¥

[dave

[ davepb:

By enlering the proper commands, you can polentially speed up your
broadband connection.

sysctl -w net.inet.tcp.delayed ack=0

As we said, the system responds to the information sent by hosts,
letting them know that the data made it through intact. Howewver, by
default the system waits to send this response until it has something
else (like a request for another piece of data) to send, and then
piggybacks the response on top of that second request. While this
practice appears silly, it actually makes sense over slower
connections, where you don’t want to waste bandwidth. But you've
got broadband, baby, and the default setting can slow you down since
the host computer will wait longer than necessary to send you the next
packet. By setting this option to o (1 is the default), you're telling the
computer to send its response immediately, which can dramatically
increase the perceived speed of large downloads.

STEP 3: Type logout to log out of root mode, then type it again to
log out of the Terminal (or just press Control-D twice). The best way to
test whether your tweaks are in working order is to head to one of the
various bandwidth-testing sites on the Internet (we like DSLReports,
www.dslreports.com) and use those tools to see what kind of results
you're getting. Ifyou are on a network at your place of work, oftentimes
the internal routers do their own routing translation, so you may not
notice a speed difference.

STEP 4: This hack only works for the current session. If you reboot
your machine, the settings you just tweaked revert to their defaults.
However, if you test them and like the results, you can modify one of
the startup files to make these settings change automatically every
time you start up your machine, To do that, type the following into
the Terminal:

sudo pico fetc/rc

With the amow keys, scroll all the way down to the bottom. The last
line should read exit 0. Position the cursor right above that line and
type the three commands from step 2 again, one per line. Press
Control-X to exit, press ¥ when the Terminal asks if you want to save,
and you're all set. Now the system will change your broadband
settings each time you boot up.

fusr/binflogin (ttypl)

stom - ossumes Lhis is porse-able by sh

l =» net.inet.tcp. sends
ayscil =w nol.inet.lcp.deloyed_ock=8

exit B8

By adding these commands lo your fetc/re file, you can set them to change
automatically al startup.
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GEEK SPEAK: Modify Your Finder Preferences and Change the Format of Aliases
ENGLISH: Change Your Finder’s Alias Font Style

File aliases are a wonderful thing. But depending on what size monitor you use, the italic

font they appear in isn’t always the most legible type. Wouldn't it be great if you could ditch

that icky look? Read on, bleary-eyed stranger.

How to Do It
STEP 1: Make a duplicate of
your Finder Preferences file. This
file resides in the Preferences
folder within your System Folder.
Open up ResEdit and navigate to
the copy you made. Find the fvig
resource, open it, and choose
resource 10 128,

STEP 2: You'll see a bunch of
numbers that mean nothing to
you. No wormries—the end of the
second line is all that matters.
That number ends with oooz.
Change the last two digits to o5
and your alias font will appear
in bold and underlined (but not
italic). The combinations here
are endless (and we urge you to
experiment!); here are some
other alternatives for tweaking

eogaas
pedaila
eegaila
eDgaze
pepaza
Degeca
bogaaa
oga4a
oaga4s
oegasa
POea5a
PeBa5a
e ls e

There are a few
resources in the
Finder Preferences
file. Open iviB

There is typically only
one vl8 resource.

0 Depd Doea
2080 doas
oeaa 2a3c
ogga BooE
2ace aavs
[eae oo
oBga gooe
pege eooe
2000 Qaaz

3 Peood 2o9ea
oege gooe

0 Po90 o800
2902 2200
2888 2ao0

the last two digits:
10—Shadowed font
o01—Bold font
o3—Bold, italic font
o8—0utline font

STEP 3: Quit ResEdit, agree to save
the changes, and you're almost set.
Just move your ariginal Finder
Preferences file to the desktop or
Trash (but don’t empty it yet), put the
hacked Finder Preferences file in the
Preferences folder, and delete the

* word copy. Restart your computer,

and you're good to go.

Once you rebool, your aliases should
look different. You can also change the
font of your aliases via the Control
Panels for a radically different look

Make sure you edit the last two numbers of line 2 (ignore the
gibberish to their right).

| & Flle Edit Uiew Window Special Help

File Edit Uiew Window Special

You can also go for
the incredibly hard-
to-read outlined look.

Hacking
Resources

Can't get enough? Check out these resources
for more hacks.

Mac OS5 X Hints (www.macosxhints.com)
These folks have done a great job of
compiling hacks and obscure information
about Mac OS5 X. We're sure their test
machines are quite accustomed to regular

reformatting and reinstallation, since they do
test most, if not all, of the hacks they publish.
The reader comments generally advise you
of any pitfalls you may encounter.

ResExcellence (www.resaxcellence.com)
This site has been around for a good long
time, and its archive of Classic and Mac OS 9
hacks (along with updates) testifies to that.
Recently ResExcellence has begun to cover
Mac OS X hacks as well, making this site a
definite must-visit for all hackers.

Terminal
Trouble

Because it has a variation of Unix at its core,
Mac OS X includes the Terminal application,
a program that allows you to talk directly to
05 X's command line. Every panel in System
Preferences is really just a GUI interface for
command-line functions. As you can see
from the hacks here, the wealth of options
goes way beyond what Apple's programmers
have selected to include in their check boxes
and menus. Along with this newlound
freedom comes the possibility that you'll pay
dearty for your mistakes. For instance, if you
enter the wrong command in Terminal, you
can get yourself stuck without access to the
command line to fix anything. Here's what
you need to know to bail out of Terminal.

if you enter a command in Terminal and
the system just sits there without returning you
to the command prompt, you can usually get
back in control by pressing Control-C (yes,
that's Controd, not Command—this is Unix,
remember?). That will stop whatever process
you started, and it should retumn you to the
prompt. If that measure doesn't work, close
the Terminal window. However, just because
you close the window doesn't mean all the
processes have stopped running. if you get
stuck and all you can do is close the window,
it's probably best to restart your machine
ASAP o ensure No emant process is causing
undue harm to your system.
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Advanced Hacks

Stepping up the level of trickery—and treachery.

GEEK SPEAK: Modify the HIToolbox.rsrc to Customize Your lcons

ENGLISH: Change Your Trash Icons

Mac 05 X introduces a beautiful new icon architecture that allows you
to pepper your desktop with resizable, full-resolution icons. But what
if you want to change one of them? You can change folders and hard
drive icons the old-fashioned way (as long as you're an Admin) using
good ol' copy and paste. But if you want to change, say, the default
icon for CDs or the Trash, the process is not that straightforward.
Follow these steps and you'll be well on your way to making your Mac
truly your Mac.

How to Do It

STEP 1: Locate the file HiToolbox.rsrc. You'll find it in the following
hierarchy of folders: System » Library » Frameworks » Carbon.framework
»Versions » A » Frameworks » HIToolbox.framework » Versions » A »
Resources (ever get the feeling that someone doesn’t want you to find
something?). Hold down the Option key and drag this file to the
desktop to make a duplicate. This step is imperative—the hack won't
work if you skip it.

The HiToolbox.rsre file, buried deep within the System Folder, is where you'll
find all of the Syslem's default icons.

STEP 2: Grab a copy of Mscape Software's
lconographer X ($15) off the Disc or from
www.mscape.com/products/iconographer.html,
making sure you get version 2.2 or later, as this
includes support for what you're about to do. Launch
Iconographer. From the File menu, choose Open lcon.
Mavigate to your desktop and select HiToolbox.rsre.
You should now see a long list of icons.

The HiToolbox.rsrc file contains hundreds of icons for your
system resources, including the two Trash icons.

STEP 3: Go online and choose a replacement Trash icon or make
your own (see “Make a Mac 05 X Icon,” pS6). For our purposes, we
chose one of Mikkel Madsen's creations called Purple II, available at
www.mmicons.com. Just remember that you need two icons: an empty
trash can and a full one,

STEP 4: Open the
empty Trash icon within
Iconographer, the same
way you opened
HiToolbox.rsrc. From the
Edit menu, choose Copy,
and then lcon Family from
the submenu.

Make sure to choose Icon Family when copying
your icons within Iconographer—otherwise the
backgrounds won't come with them.

STEP 5: In HiToolbox.rsre,
scroll down to lcon ID =3993
(which correlates to the
empty trash can) and double-
click to open that family.
From the Edit menu, choose
Paste, and then lcon Family
from the submenu. Close the
window and agree to save
the changes.

Icon number —3993 is
Io replace.

the one you want
STEP 6: You're done with
the first halfl Now just repeat
steps 4 and 5 with the full- 0 g A i e s Lottt
trash icon (ID —3984). Quit 1

Iconographer once you're
finished making changes to
the icons.

STEP 7: Now you need to
put the modified copy of
HiToolbox.rsre in the proper
place so the system will use
it. Unfortunately, only root users can modify the Resources folder—just
dragging this file back into that folder will result in an emror. At this
point, you have two options. The first is to use your previous hack of
making a version of Finder that runs as root (see “Gain Easy Access to
Finder Files,” p22) using the program Pseudo, which will allow you to
drag and drop your file into the Resources folder. The other option is to
open Terminal and type the following command:

Another page or two down from Trash
Empty, you'll find Trash Full

sudo cp -/Desktop/HITocolbox.rsrc /System/Library
/Frameworks/Carbon. framework/Versions/A
/Frameworks /HIToolbox. framework/Versions/A
/Resources/HIToolbox.rsrc

fusribinflogin fmypll

You need to be a root user to replace the HiToolbox.rsrc file. These are the
commands you enter in Terminal.

STEP 8: When you're done, log out of your Mac, log back in, and

enjoy your new icons!
e T
3o W o

Enjoy your new Trash. You deserve it.
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GEEK SPEAK: Move Your Virtual Memory Swap File to Another Drive or Partition

ENGLISH: Free Up Hard Drive Space

You all know Mac 05 X is based on Unix, and you all know (or at least
can pretend to know) that Unix has an awesome virtual-memory
system built in. What you don’t know is that Apple chose to implement
Mac 05 X's virtual memory in a somewhat unorthodox fashion. Most
Unix systems designate a completely separate partition for its swap
files (files the operating system uses to store disk info that won't fit in
RAM). However, Apple has set Mac 05 X to put the swap files on the
same volume as all of your other data—but for good reason. Imagine
telling users they need to repartition their drives just to run Mac 05 X.

Unfortunately, Apple’s method can cause a few problems. Number
one is that the swap files are fixed at about 8oMB in size (76.2MB, to
be nitpicky). These files are normal files, and they suffer from the same
fragmentation issues that plague the rest of the stuff on our hard
drives. Having a fragmented swap file isn't good, especially if you're
low on RAM because that's when your system is most likely going to
use a swap file. To solve this problem, you can tell Mac 0S5 X to put its
swap file(s) on another drive or partition, which can greatly improve
your system’s performance, depending on how fragmented and full
your drive was to start with. The reasoning is that if your swap partition
starts out completely empty, and the only files the system creates there
are BoMB swap files, then you'll only have 8oMB chunks of space on
the drive, This eliminates the fragmentation that would happen if you
were also saving (and deleting) applications, documents, and other
files of different sizes on the same partition. Beware: This is a
potentially dangerous hack. Proceed with caution!

For this hack, you'll first have to reformat your drive (or install
another drive) and set aside a small HFS+ partition (250MB to 750MB
is more than enough). You can also use an extemnal drive—but be
careful when you disconnect it (see “Waming!”, p2g). Since this hack
is for truly hard-core users, we're going to assume you know how to
reformat a drive. Once you're done, read on.

How to Do It

Create a new

=

STEP 1: Choose a name for the drive or partition,
partition you wish to use as a swap device. ~ ~©  making sure
MName it anything you want, but don’t use E!'- it doesn't
spaces. StellaByStarlight is the name of . have spaces
our partition. et In its name.

STEP 2: Most of what you're about to do requires that you be in root
mode. Get thee to a Terminal window, and set yourself up as root by
typing sudo -s and pressing Retumn. Type df -k and look at the list
to determine your partition's Filesystem location—the first column in
the listing, this information typically starts with /dev. Filesystem
describes the specific disk and partition your Mac is using for a given
volume. StellaByStarlight is using Filesystem /dev/diskosy and is
mounted on Volumes/StellaByStaright. Make a note of these details.

Avail Copacity PMounted on
] ./
Ao lumes, Stal LoByS

Hlwe type df -k, we see that our StellaByStarlight drive is located at
fdev/disk0sT—your info will likely be different.

STEP 3: Since the system initializes the swap file at the beginning of
the system startup sequence to refresh it with the current data, you
need to tell the system to bring this new partition online earlier than it
normally would. (Mac 05 X typically brings only the boot volume online
at the beginning of the startup process.) Create an entry in the
Jetc/fstab file (located in /Hard Drive/etc/fstab). This file contains a
list of the drives (and their respective Filesystems) that the system will
mount at startup. From the command line, type pico fetc/fstab
and press Return. You'll end up in a text-based editor window. Type the
following, all on one line with spaces between each block (but make
sure you replace our Filesystem info with your own):

/dev/disk0s7 /Volumes/StellaByStarlight hfs rw 1 2

Once you've typed these commands, press Control-X (aka exit), Y,
and Return to save your changes to this file.

fusr/binflogin

(typ)

Boev/diskis?  Aoluses/StelleByStarlight his

Add the proper syntax to the fetc/Tstab file to tell your Mac to mount your
swap drive early in the starlup process.

STEP 4: Now that you've created the new swap partition and told the
system to mount it early enough in the startup process, you need to tell
the system to use this partition as your new swap-file storage location.
From the command line, type pico fetc/rc and press Retum. This
opens up another text-editor window, this time with a file full of shell-
script commands that tell your Mac
how to start up. From here, be sure
to follow our directions exactly,
otherwise your Mac may never boot
properly again (and that would suck).
Find the right location to edit.
Press Control-W, type swapdir,
and press Return. Terminal should
bring you to a line that says
swapdir=/private/var/vm.

stly inte wedef
st kiLl  wedef

Pressing Control-W, then typing the
word swapdir and pressing
Return tells pico to search the entire
document for a specific bit of text.

STEP 5: Using only the keyboard, you must position your cursor at
the end of this line, and completely delete the /private/var/vm
portion. Replace this with /Volumes/StellaByStarlight/vm
(using your own info, of course). Our final line reads:
swapdir=/Volumes/StellaByStarlight/vm. Now press
Control-X, type Y for yes, and press Return to save the file to disk.

fusribinflogin (yp2) . e
L PIioctey 2.3 Flles Jeterre  Paditisd I

]
# Start the virtuol sesory systes.
p o

Cormalefiessogs “Starting virtuol sosory™

Ewapd i e Vo lumesSta | (oByStar | Iw:.-"nl

# Fokes mure the swopf ils exists
ir} 1; then
¢ “Creating defoult swop directory™

Replace /private/var/vm with the proper path to your partition.



STEP 6: Restart your Mac. Assuming you've done everything
comrectly, you should see a folder on your new disk titled vm (short for
virtual memory, presumably), and within it a file named swapfileo,
where your system will now store any data it needs to hand out from
RAM to the disk. If this file exists, give yourself a big pat on the back!

LA vmi
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Comguter Woma Favortes  Agplications

Aler you restart,
you should see a

Eack e
i i Baglcity

i Tempesary Rems 2 swuphiled
Vipe 5 folder titled vm
e f— on your new
disk. If you do,

3 SeellaByStarlight =

congratulations!

STEP 7: Hold your horses! Chances are your Mac still has an old
76.2MB swap file it no longer needs. In Terminal, type sudo rm
/private/var/vm/swap*. This command deletes the old swap
file(s) and frees up space. To revert your system to the way it was (and
store your swap files in their original location), change the fetc/rc file
to read swapdir=/private/var/vm. You can also remove the
swap partition, and 05 X puts the files back on your original drive,

albeit in the Volumes folder—this method is a bit unorthodox, but it
won't break anything. And that's what's important.

Removing the old, unused swap file from your main hard drive will free up at

least 75MB of space—maybe more.

WARNING! This hack involves telling your system specifically which
drive to look for when creating swap files. If your drive configuration
remains the same, you won't have any problems. However, if you
remove or change the drive containing your new swap files, Mac 05X
will either put the swap files back on your main drive (in the Volumes
folder) or put them on another drive (to restore your swap files to their
original location, see step 7). Bottom line: Be iber-aware of the way
you configure your drives, and make the appropriate changes should
you choose to rearrange them after performing this hack.

GEEK SPEAK: Hack MENU Resources to Create a New Keyboard Command
ENGLISH: Create a Shortcut for Hide Others

Have you ever been working in an application and wanted to purge
your desktop of everything except what you're working on? Sure, you
can slide your cursor all the way up to the right comer of your screen
and choose Hide Others—but that's a lot of mousing for a busy person
like yourself. Enter this hack, which allows you to add a keyboard
shortcut for your Hide Others menw.

How to Do It

STEP 1: Make a copy of your System file. In ResEdit, open the System
copy that now exists in your Mac's System Folder
(you want to work on the copy—you never want
to work on a live System file unless you don't
value your Mac). Double-click the MENU
resources—the System file contains lots of
resources, but thankfully ResEdit organizes

them alphabetically.
Scroll down to find the MENU

resource bundle, then double-click it.

ORI

STEP 2:You'll see a
handful of resources, but
you want one named
Maura. (Incidentally,
there’s another one here
called rANdy—who says
the Mac 05 doesn't have
any more Easter eggs?)
When you find Maura,
double-click it.

Double-click the Maura resource (bul not
if she's sitting right next to you...that
would be rude).

STEP 3: You'll see a list of menu options—click Hide Others once.
Now you'll see a list of options you can set. Look for the box next to
Cmd-Key and type whatever keystroke you want to use in combination
with the Command key to enact this menu item. Bear in mind that it
shouldn’t be anything your other apps use, lest the system get
confused. We used the backslash key, and thus far it hasn't given

us problems.

By putting a
backslash into
the Cmd-Key
option, we can
sel a keyboard
shortcut for
hiding other
= 1A s applications.

STEP 4: Quit ResEdit and agree to save changes to the System copy.
Mow throw your existing System file in the Trash (but don't empty it vet).
Rename System copy as System (or to play it really safe, just move the
System file to your desktop). Restart your Mac. Assuming everything
worked comectly, you should now be able to press Command-
backslash to hide applications. If all is working properly, go ahead

and empty the Trash.
I . ooz

Hide ResEdit 2.1.3+
Hide Others
Show All

K] Finder
MyBattery for iBook/FireWire PB
v B ResEdit2.1.3+

Once you restart, check your
Applications menu to see if
the new shortcut appears.

Dave Hamilton, president of the Mac Observer (www.macobserver.com), spent many of his formative years tweaking
Unix systems before moving to the Mac. The fact that Mac 05 X is based on Unix still brings a tear of joy to his eye.
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